
Chapter 1

Getting Familiar with 
the Excel 2007 Interface

In This Chapter
� Identifying the different parts of the Excel display screen

� Selecting commands on the Office menu

� Selecting commands on the Ribbon

� Customizing the Quick Access toolbar

The Excel 2007 interface has been completely revamped and redesigned compared to
the older versions of Excel we’re all used to. In place of the old pull-down menus, so

prominent in all earlier versions of the program, Excel 2007 now relies primarily on the
Ribbon, a block of commands displayed at the top of the screen and divided into dis-
tinct blocks called tabs. All that’s left of the old pull-down menus is the pull-down menu
opened with the Office Button, which replicates most of the File commands. Also, in
place of the many toolbars of previous Excel versions, Excel 2007 offers a single toolbar
called the Quick Access toolbar.

The exercises in this first chapter are designed to get you familiar with the new Excel
2007 interface. As a result of doing these exercises, you should be comfortable with all
aspects of the display screen and the command structure and ready to do all the rest of
the exercises in this book.

Identifying the Parts of 
the Excel Display Screen

Before you can start using Excel 2007, you have to be familiar with its display screen.
Figure 1-1 shows you the Excel 2007 display screen as it first appears when you launch
the program. Note the names of the different parts of the display screen before you per-
form Exercise 1-1.
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Figure 1-1:
The Excel

2007 display
screen as it

appears
when you

first launch
the

program.
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Q. What are the primary functions of the commands on the Office menu?

A. To open, close, save, and print your Excel spreadsheet files and change the Excel program
options.

Q. What is the primary function of the Quick Access toolbar?

A. To enable you to quickly select Excel commands that you use all the time without having to
open the Office menu or use the Ribbon commands.

Q. What’s the primary function of the Ribbon in Excel 2007?

A. To group related Excel commands together and give you quick access to these commands.
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Selecting Commands on the Office Menu
Clicking the Office Button opens the only pull-down menu in Excel 2007. Almost all the
commands on this pull-down menu are related to actions that affect the entire file, such
as saving and printing. If you prefer, you can open this menu by pressing Alt+F (F for File)
instead of clicking the Office Button.

Exercise 1-1: Opening the Office Menu and Selecting Its Commands
In this exercise, you get familiar with the commands on the Office menu as you practice
opening the Office menu and selecting some of its commands. Make sure that Excel 2007
is running and an empty Sheet1 worksheet is active on your computer monitor (see
Chapter 2 if you need information on launching Excel).

1. Highlight the Office Button (by hovering the mouse pointer over it without clicking
the mouse button) and wait until its ScreenTip appears.

The ScreenTip shows you an image of the menu and gives you a brief description
of its function.

2. Click the Office Button to open its pull-down menu.

Note the commands New through Close in the left menu pane. Also note the Excel
Options and Exit Excel command buttons at the very bottom of the menu.

3. Highlight the Save As command on the Office menu (but don’t click it).

Note all the Save a Copy sub-options that now appear in the right menu pane.

4. Now, click the Save As command on the Office menu to select it.

Excel opens the Save As dialog box where you can modify the name, location, and
type of Excel workbook file before saving a copy of it.

5. Press the Esc (Escape) key on your keyboard to close the Save As dialog box.

6. Press Alt+F to open the Office menu again, this time from the keyboard.

This time, small letters appear on each command as well as on the sub-option
buttons attached to the Save As and Print commands. These are the access keys
that you can type to select an option rather than clicking its name or button.

7. Type W to display the Print command sub-options, and then type V to select the
Print Preview sub-option.

Excel displays an alert dialog box indicating that there’s no data in the Sheet1
worksheet to preview. Note the appearance of the dashes in the Excel worksheet
display showing where the pages would be divided.

8. Click OK in the alert box and then press Alt+FI to open the Excel Options dialog box.

The Excel Options dialog box contains all the options for changing the Excel pro-
gram and worksheet options. These options are divided into categories Popular
through Resources.

Solve It
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9. Click the Advanced button in the left pane to display all the Advanced options in
the right pane. Next, scroll down to the Display Options for This Worksheet section
and click the Show Page Breaks check box to remove its check mark before you
click the OK command button to close the dialog box.

Note that deselecting the Show Page Breaks option in the Excel Options dialog box
removes all the dashed page break lines from the Sheet1 worksheet.

Selecting Commands from the Ribbon
The Excel Ribbon contains the bulk of all the commands that you use in creating, editing,
formatting, and sharing your spreadsheets, charts, and data lists. As shown in Figure 1-2,
normally the Ribbon is divided into seven tabs: Home, Insert, Page Layout, Formulas,
Data, Review, and View. The commands that appear on each tab are then further divided
into Groups, containing related command buttons. Also, many of these groups contain a
Dialog Box Launcher button that appears in the lower-right corner of the Group. Clicking
this button opens a dialog box of further options related to the particular Group.

Exercise 1-2: Selecting Commands from the Ribbon
In Exercise 1-2, you get practice selecting commands from the Ribbon. Make sure that
Excel 2007 is running and an empty Sheet1 worksheet is active on your computer monitor.

1. Click the Formulas tab to displays its commands.

Note that the commands on the Formulas tab are divided into four Groups:
Function Library, Defined Names, Formula Auditing, and Calculation.

2. Press the Alt key.

Note the access-key letters that now appear on the Office button, Quick Access
toolbar options and the Ribbon Tabs.

If you prefer selecting Excel commands from the keyboard, you’ll probably want to
memorize the following access keys for selecting the seven tabs:

Home tab: Alt+H

Insert tab: Alt+N

Solve It

Tab

Group Dialog Box launcher

Figure 1-2:
The normal
Excel 2007

Ribbon.
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Page Layout tab: Alt+P

Formulas tab: Alt+M

Data tab: Alt+A

Review tab: Alt+R

View tab: Alt+W

3. Type W to display the contents of the View tab and then type VG to remove the
check mark from the Gridlines check box in the Show/Hide Group.

4. Click the Gridlines check box to select it again and redisplay the gridlines in the
worksheet.

As you may have noticed, the Ribbon takes up quite of bit of screen space that is
otherwise used to display worksheet data. You can take care of this by setting
Excel to minimize the Ribbon each time you select one of its commands to display
only the tab names.

5. Click the Customize Quick Access Toolbar button (the button with the line and
downward-pointing triangle at the end of the Quick Access toolbar) and then click
the Minimize the Ribbon option at the very end of this menu.

Excel immediately minimizes the toolbar to display only the seven tab names.
As long as this option is selected on the Customize Quick Access toolbar menu
(indicated by a check mark in front of its menu option), Excel continues to reduce
the Ribbon to its tab names any time after you select one its commands.

Keep in mind that you can expand the Ribbon to display all the command buttons
on the currently selected tab any time that the Ribbon is minimized simply by
double-clicking the tab or pressing Ctrl+F1.

6. Click Data on the minimized Ribbon.

Excel expands the Ribbon to display all of the Data tab command buttons.

7. Click anywhere in the worksheet area to minimize the Ribbon once again.

The only problem with this minimized Ribbon arrangement is that the temporarily
expanded Ribbon covers the first three rows of the worksheet. This makes it very
difficult to work with data at the top of the worksheet. For that reason, as well as to
help you get comfortable with unfamiliar Ribbon commands, you will work with
the Ribbon expanded at all times in all remaining exercises in this workbook.

8. Click the Customize Quick Access Toolbar button and then click the Minimize the
Ribbon option to deselect this option by removing its check mark. Then, click
the Home tab to displays its command buttons.

The Ribbon now remains fully displayed at all times as you select any of its tabs
and command buttons without ever obscuring any part of the worksheet display.
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Selecting Commands on the Quick
Access Toolbar

When you first start working with Excel 2007, the Quick Access toolbar contains only the
following three simple command buttons:

� Save to save changes to your current workbook file

� Undo to reverse the effect of the last change you made to a worksheet

� Redo to restore the last change you reversed with the Undo button

Customizing the Quick Access toolbar
In addition to the three default command buttons, the Quick Access toolbar contains a
Customize Quick Access Toolbar button (the one with the line above a downward point-
ing triangle) that when clicked opens a pull-down menu. The options on this pull-down
menu enable you to quickly customize the command buttons on this toolbar. In addition,
you can change the placement of the toolbar by moving it down so that it appears imme-
diately below the Ribbon and above the Formula bar.

Exercise 1-3: Quickly Customizing the Quick Access Toolbar
In Exercise 1-3, you get practice customizing the contents and position of the Quick
Access toolbar using options that appear on the Customize Quick Access Toolbar menu.
Make sure that Excel 2007 is running and an empty Sheet1 worksheet is active on your
computer monitor (see Chapter 2 for information on launching Excel).

1. Click the Customize Quick Access Toolbar button and then click the Show Below
the Ribbon option on its menu.

The Quick Access toolbar with its three command buttons and the Customize
Quick Access Toolbar button now appears immediately above the Formula bar.

2. Click the Customize Quick Access Toolbar button and then click the Quick Print
option.

Excel adds the Quick Print button to the Quick Access toolbar that you can click to
send the current worksheet to the printer.

3. Use the same technique to add the New, Open, and Print Preview command buttons
to the Quick Access toolbar on your own.

Use the ScreenTips attached to each button to verify that you’ve correctly added
the Quick Print, New, Open, and Print Preview buttons to the Quick Access toolbar,
noting the shortcut keys listed.

Solve It
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Adding more commands to the 
Quick Access toolbar
When customizing the command buttons on the Quick Access toolbar, you aren’t limited
to the selection of commands that appear on the Customize Quick Access Toolbar pull-
down menu. Using command options that appear in the Excel Options dialog box, you
can add buttons for any of the commands that appear on the various tabs of the Ribbon
as well as some Excel commands that remain completely unavailable until you add them
to the Quick Access toolbar.

Exercise 1-4: Adding Commands from the Excel Options Dialog Box to the Quick
Access Toolbar
In Exercise 1-4, you get practice customizing the contents of the Quick Access toolbar
using commands that appear in the Excel Options dialog box. Make sure that Excel 2007
is running and an empty Sheet1 worksheet is active on your computer monitor (see
Chapter 2 for information on launching Excel).

1. Click the Customize Quick Access Toolbar button and then click the More
Commands option on its menu.

Excel opens the Excel Options dialog box with the Customize tab selected (see
Figure 1-3). This dialog box contains two list boxes:

• Choose Commands From list box on the left where you select the commands
to add to the toolbar

• Customize Quick Access Toolbar list box on the right, showing the buttons
on the toolbar and their order

To add a new command to the toolbar, you select it in the Choose Commands From
list box and then click the Add button. To reorder the buttons on the toolbar, you
click its command button in the Customize Quick Access Toolbar list box and then
click the Move Up or Move Down buttons (with the black triangles pointing up and
down, respectively) until the selected button is in the desired position.

2. Click the drop-down button on the Choose Commands From drop-down list box
and then click the Commands Not in the Ribbon option on its drop-down menu.

The Choose Command From list box now contains only command buttons that are
not found on the various tabs of the Excel Ribbon.

3. Click the AutoFormat command option in the Choose Commands From list box
(the one with the lightning bolt on top of a small table) and then click the Add
button.

The AutoFormat command option is now listed at the very bottom of your
Customize Quick Access Toolbar list box, indicating that it is now the last button
on the Quick Access toolbar.

Solve It
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4. On your own, add the Calculator, Draw Borders, Form, Speak Cells, Speak Cells –
Stop Speaking Cells, Speak Cells by Columns, Speak Cells by Rows, and Speak Cells
on Enter command options to the Quick Access toolbar.

You may have to scroll down the list of command options in the Choose
Commands From list box in order to select and add the Draw Borders, Form, and
the different Speak Cells command options to the Quick Access toolbar.

Next, you want to modify the order in which the command buttons appear on
your customized Quick Access toolbar so that they appear in this order arranged
in four groups:

• New, Open, Save, Quick Print, and then Print Preview

• Undo and then Redo

• AutoFormat, Calculator, Draw Borders, and Form

• Speak Cells, Speak Cells – Stop Speaking Cells, Speak Cells by Columns, Speak
Cells by Rows, and Speak Cells on Enter

5. Click the New command option in the Customize Quick Access Toolbar list box to
select it and then click the Move Up button (the one with the black triangle point-
ing upward) until New is the first command in this list (four times).

6. Use the same technique to move the Open command button up until it appears
between the New and the Save button.

Figure 1-3:
Customizing

the Quick
Access tool-

bar using
the Excel

Options
dialog box.
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7. Use the Move Down button to move the Undo and Redo buttons so that they now
appear in the same order below the Quick Print and Print Preview buttons.

The command buttons for your customized version of the Quick Access toolbar
now appear in the correct order in the Customize Quick Access Toolbar list box in
the Excel Options dialog box. The only other thing you need to do is to divide them
into groups by adding a vertical bar called a separator.

8. Click the Print Preview command option in the Customize Quick Access Toolbar
list box to select it and then click the Separator option at the very top of the
Choose Commands From list box to select this option. Click the Add button.

Excel inserts a separator between the Print Preview and Undo command options in
the Customize Quick Access Toolbar list box.

9. Use this same technique to add a Separator between the Redo and AutoFormat
command options and the Form and Speak Cells command options in the
Customize Quick Access Toolbar list box.

Your customized Quick Access toolbar now contains four groups of command but-
tons created by the three Separator options that appear after the Print Preview
command option, Redo command option, and the Form command option.

10. Click OK to close the Excel Options dialog box. On the Quick Access toolbar, click
the Customize Quick Access Toolbar button followed by the Show Above the
Ribbon option on its menu.

The final version of your customized Quick Access toolbar now appears once again
above the Ribbon to the immediate right of the Office button. Check the buttons on
your customized toolbar against those shown in the toolbar in Figure 1-4.
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Figure 1-4:
Excel dis-

play screen
showing

the final ver-
sion of the

customized
Quick

Access
toolbar.
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